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1. The Purpose of the Quick Start 
The FloorRight™ Quick Start will help you to install and use FloorRight in a very short 
time. Soon, you will have the software installed and you will be able to create bid 
estimates. Then, with practice and assistance from the tutorial and help files, you will be 
able to quickly create competitive bids for any customer. 

1.1. Who Should Use the Quick Start 

1.1.1. Network and System Managers 
The people who manage the computers in your store can use the Quick Start for guidance 
in installation and licensing of the software. 

1.1.2. First-Time Users 
People who are unaccustomed to working with computers will find the Quick Start very 
helpful in learning how to manipulate a point-and-click environment, as well as becoming 
familiar with the features and functions of FloorRight. 

1.1.3. Experienced Users 
Experienced FloorRight™ users can learn about new features, as well as more in-depth 
information on features they might already be familiar with. 

1.2. Topics the Quick Start Covers 
The Quick Start is intended as a launch point for using FloorRight. Information for most 
features has been left out of this document to keep you focused as you begin using 
FloorRight. Features covered in the Quick Start include: 

• Setting up FloorRight 
• Introduction to the basic tools 
• Creating and editing simple rectangular rooms 
• Importing drawings into FloorRight 
• Working with one material 
• Viewing and printing the estimate 
• FloorRight Commercial™ features 
 

1.3. Where to Go for More Information 

1.3.1. FloorRight™ Tutorial 
The FloorRight™ Tutorial is the easiest and fastest way to get competency in FloorRight. 
The tutorial gives you a hands-on demonstration of the application, as well as step-by-step 
guidance through some of the more sophisticated features. We encourage you to use it. The 
FloorRight Tutorial can save you a lot of time in the day-to-day use of FloorRight. 

You can start the tutorial by placing the FloorRight disk in the CD player of your 
computer. The computer screen will show a dialog box with the option Run Tutorial. 
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To run the tutorial, it is not necessary to have FloorRight installed on the hard disk of your 
computer. The tutorial can be run directly from the CD drive. However, once you have 
installed FloorRight you do not have to run the tutorial from the CD. You can access it 
from the FloorRight program group from the Start button on the Windows taskbar. 

1.3.2. FloorRight™ Help 
FloorRight™ includes a complete help system, including the ability to get context-sensitive 
help on what you are currently working on. Press F1 at any time when running FloorRight, 
or click on the Help menu, and choose Help Topics. 

The Online Help includes a table of contents for common topics, and is fully indexed to 
help you get quick answers to your questions. 

1.3.3. FloorRight™ FAQ 
The answers to many “frequently asked questions” are included at the end of this 
document. You can browse through this list to give you a better idea of what to expect, or 
you can search through it when you have a particular question of your own. 

1.3.4. FloorRight™ Web site 
For more information on using or obtaining FloorRight, see the FloorRight web site: 
http://www.floorright.com/
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2. Installing FloorRight 

2.1. Hardware Requirements 
The minimum hardware requirements for FloorRight are: 

• 32 megabytes of RAM 
• 100 megabytes of disk space 
• Pentium ™ or compatible processor (166 MHz or faster recommended) 
 

2.2. Recommended Screen Settings 
Minimum screen settings for proper FloorRight function are 

• 256 color display 
• 800x600 display resolution 

Although 256-color mode is adequate for FloorRight, the software takes full advantage of 
True Color. If you choose a lower level of color depth, you may wish to be judicious in 
your choice of colors for the materials you set up. Clicking the Solid color in the Add New 
Material dialog box will prevent mottled looking displays and interference with the text in 
a room. 

A higher color depth - either High Color or True Color - is recommended for the best 
visual appearance. 

2.3. Performing the Installation 
In order to install FloorRight correctly on Windows NT, 2000, or XP Pro, you must be 
logged on with Administrator privileges, otherwise the FloorRight licensing mechanism 
will not work. Administrator privileges are only necessary when installing FloorRight. 
Once installed, anyone who has access to the FloorRight directory, not just administrators, 
will be able to run FloorRight. 

The setup procedure is a set of self-explanatory dialog boxes that will lead you through the 
installation process.  

If this is the first time you are installing FloorRight on your computer, place the CD in the 
CD player of your computer. An “InstallShield” dialog box will pop up. The setup will 
take a few seconds to prepare the InstallShield Wizard, which will guide you through the 
program setup process.  

If the installer doesn’t automatically run when you put the CD in the drive, you can start 
the installation of FloorRight by double clicking on the “My Computer” icon on the 
Windows desktop. Then you will need to double click on the CD icon, which should be 
labeled FloorRight. Finally, double click on setup.exe to start the setup process. The 
following dialog box will appear 



 

 
Click Next and FloorRight will install WiBuKey support to your system. 
 
Next, the License Agreement popup and you have to accept the agreement in order to 
continue the installation. 
 
The next dialog box asks for your user name and your company name. Enter the 
information and then click on the Next button to continue. 
 
The next dialog box asks for your company’s address and phone number. Again, enter the 
information and then click on the Next button to continue 
 
By default, FloorRight is installed in C:\Program Files\FloorRight.  If you want to install 
FloorRight in another directory, click on the Browse button when you get to the following 
dialog, and then browse to the folder where you want FloorRight to be installed. To 
continue with the installation, click on the Next button. 
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The next dialog box asks you if you want to use USA defaults or the metric defaults.  This 
setting controls what the default materials are.  Select one and click on the Next button. 

The last dialog box asks you whether you want to copy settings from previous version or 
not.  By default, the “Copy settings from previous version” checkbox is checked. If you 
don’t want to copy the settings from previous version, then uncheck this checkbox.  

Click Next to review the settings and then click Next again to begin copying files. If the 
installation is success, you will get the following dialog 
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Clicking Finish with “Check for updates” checkbox checked will take you to the 
TrueUpdate service. If you don’t want to check for program updates, then uncheck this 
checkbox before clicking on the Finish button.  

Now, the installation is finished and you can remove the CD from the CD player. 

2.4. Obtaining a License 
If you are running FloorRight without a WIBU-key connected to your computer, or if the 
network license is not available, then some functionality will be disabled. You will not be 
able to save or print and FloorRight will only run for 60 minutes. In addition, you will not 
be able to enter or see prices for materials and estimates. To buy a FloorRight license, you 
should contact your FloorRight distributor.



 

3. Creating an Estimate 

3.1. Starting FloorRight 
Now that you have installed your software, you can find FloorRight on the Start menu 
under Programs. The steps for creating a bid estimate are: 

1. Define rooms in the FloorRight system. 

2. Describe the materials to FloorRight and assign them to rooms. 

3. Determine the estimated price for the job. 

4. Provide the information to your customer. 

3.2. Defining Rooms 
Create rooms either by typing in the dimensions, or by clicking and dragging rectangles on 
the screen. Rooms that are not strictly rectangular can also be drawn. See the tutorial to 
find out how. 

3.2.1. Creating Rooms with the Text Interface 
You can create rectangular rooms by typing directly into the W x L box and the Room 
Name box on the toolbar. 

1. Type the dimensions of the room in the  box, 
separated by an “x”. For example, you would type 20’ x 18’ for a room with 
dimensions of 20 feet by 18 feet. 

2. Type the name of the room in the  box. 

3. Click on the green check mark button , or press the Enter key. 

3.2.2. Creating Rooms with the Graphical Interface 
To draw a rectangular room, start by selecting the rectangle button  from the tool bar. 
Draw your room by clicking and dragging in the room view, the part of the display directly 
below the toolbar. 

1. Depress the left mouse button in the room view 

2. Without releasing the mouse button, move the mouse cursor to where you would 
like the opposite corner to be. Notice that the dimensions of the room are 
displayed, and that they change as you move your mouse. 

3. Release the mouse button when you have the right size room. 

The rectangle button continues to be in effect until you select another drawing button. 
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3.3. Working with Materials 

3.3.1. Creating a Material 
FloorRight comes with many pre-defined material styles. A material style contains 
information about the type of material (carpet, Berber, ceramic tile, and so on), whether the 
material has a pattern, and several other considerations. Match a color code with a material 
style that matches your client’s choice, and you have created a material. 

FloorRight starts with a fairly plain material already created: carpet with no pattern and a 
width of 12 feet. If this is satisfactory, you can put off creating materials until another time. 
Otherwise, follow these steps: 

1. Locate the color drop down dialog box in the upper left corner of the tool bar. 
Click on the small triangle. 
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2. Click on Add New Material.  This will open a color dialog box (page 14). 

3. Select a color from the Color drop down menu, or use the default one. 

4. Select a material style from the Material drop down menu. 

5. Click on OK. 

Later, you can elaborate on this process, inventing new material styles. 

3.3.2. Defining Tile Materials 
A tiled material must be specifically defined in the Material Type dialog box before it can 
be used.  Select Defaults / Material Type and add a material with the following 
characteristics 

• Boxed 

• Pattern width, which is greater than zero (this is used as tile width) 

• Pattern length, which is greater than zero (this is used as the tile length) 

• Amount per box, which is greater than zero 

 
Any material with the above definition will be treated as tile.  

 

3.3.3. Assigning Materials to Rooms 
You can tell which material is being used in a room by its color. Before drawing a room, 
check in the upper-left of the display to see that the correct color and style is shown. 

If the wrong material is displayed, click the small triangle to see the rest of the materials 
you have defined, and pick the right one. 

If a room has been created and it is the wrong material, select the room and then choose the 
material as above. 

3.4. Viewing the Layout 
Clicking the seam/stock button  on the tool bar will split the window into two parts. The 
top part of the window, called the seam view, displays the location of seams in the rooms. 
The lower part of the window, called the stock view, displays the stock and how it should 
be cut. 

As you become more proficient, you may wish to tailor the placement of seams more to 
your customer’s preferences. The tutorial includes examples of how this is done. 

3.5. Determining the Price 
Click on the money button  to open the Job Estimate dialog box. You can set prices for 
materials, labor (fitting), padding (underlay) and other related items. 
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The Job Estimate dialog box contains an itemized quote for the job you are estimating. 
When you complete the estimate, this quote can be printed and given to your customer. 

The width of each column can be adjusted to your preference. Position the mouse cursor 
over the header row, just between two columns. The cursor should change into a vertical 
line with arrows pointing to the left and right. Click the mouse and drag to change the 
width of columns. 

Double-clicking the title bar of the Job Estimate dialog box will cause it to fill the entire 
screen, allowing you to see much more of the information at one time. Double-clicking 
again will return the dialog box to its original size. 

3.6. Printing Reports 

3.6.1. Room, Seam and Stock Views 
FloorRight has three views: Room, Seam, and Stock view. You can print any of these 
views by selecting the appropriate option under the File/Print menu. Note that Print 
Rooms will print the seams if you are viewing a layout. Otherwise, it will only print the 
rooms and not the seams. 

View Layout button  Print Command 

Room View Off (up) Print Rooms 

Seam View On (depressed) Print Rooms 

Stock View On (depressed) Print Stock 

3.6.2. Job Estimate 
To print a job estimate, bring up the Job Estimate screen by clicking on the  button, 
and then click on the Print… item under the File menu. 
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4. Basic Tools 

4.1. Text Entry Tools 

4.1.1.  Room Name Box 
Whenever you create a room, it will be given a name. If you don’t supply a name, 
FloorRight will generate a default name for you. You can enter a name when creating a 
room using the Room Name box. You can also change the name of an existing room by 
selecting that room, typing a new name in the Room Name box, and pressing the Enter 
key. 

4.1.2.  W x L Box 
You can enter rectangular rooms by typing directly into the W x L box and the Room 
Name box. 

1. Type the dimensions of the room in the W x L box, separated by an “x”. For 
example, you would type 20’ x 18’ for a room with dimensions of 20 feet by 18 
feet. See Entering Lengths for more information on how FloorRight interprets 
the lengths you specify. 

2. Type the name of the room in the Room Name box. 

3. Click on the green check mark button  or the Enter key. 

4. If you wish to cancel this action, click on the reset button . 

These steps can also be used to modify the name or dimensions of an existing room. First, 
select the room you wish to modify. Type your changes in the W x L box and the Room 
Name box. Again, use the green check button to accept the changes, or the red button  
to reject them. 

IMPORTANT: 
Dimensions of rooms are based on the amount of floor covering required, not on the 
distances specified by the blueprint. Please add a few inches to accommodate the 
unevenness of walls or mistakes in cutting and measuring. 

4.1.3.  Line Length, Direction 
The Line Length text box allows you to enter the length of a wall. The Dir. text box 
allows you to enter wall direction. Press the Enter key when you finish. 

4.1.4.  Accept (enter) Button 
You can accept an entry in any of the text boxes, like the W x L or the Line Length box, 
by clicking the accept button. 
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4.1.5.  Reject (cancel) Button 
You can cancel an entry in any of the text boxes, like the W x L or the Line Length box, 
by clicking the cancel button. This will discard any values that you’ve just entered. 

4.2. Drawing Tools 

4.2.1.  Rectangle Tool 
The Rectangle drop down box allows you to switch between the rectangle room drawing 
tool and the rectangular hole-cutting tool.  To draw a rectangular room, make sure the 
rectangle room drawing button is displayed on the tool bar. Draw your room by clicking 
and dragging the mouse. 

1. Depress the left mouse button in the room view 

2. Without releasing the mouse button, move the mouse cursor to where you would 
like the opposite corner to be. Notice that the dimensions of the room are 
displayed, and that they change as you move your mouse. 

3. Release the mouse button when you have the right size room. 

The rectangle button continues to be in effect until you select one of the other drawing 
buttons. 

4.2.2.  Line Tool 
Most rooms are not simple rectangles, but in many cases using a rectangular approximation 
will suffice. On those occasions when using a rectangle would cause too much waste, 
FloorRight helps you create a more efficient layout. Use the line drawing tool to specify 
non-rectangular rooms. 

The Line Drawing drop down box allows you to switch between the room line drawing 
tool and the non-rectangular hole-cutting tool.  These steps are the simplest way to draw a 
non-rectangular room: 

1. Click the room line drawing tool button on the toolbar. 

2. Click the locations on the room view where you would like the corners of the 
room to be. 

The room line drawing button continues to be in effect until you select one of the other 
drawing buttons 

4.2.3.  Rectangle Hole 
The Rectangle Hole cutter is selected by using the drop down arrow to the right of the 
rectangle button on the toolbar. When selected, the toolbar button changes to show a room 
with a rectangular hole in it and the cursor includes scissors to indicate hole cutting is 
active.  

Cut a rectangular hole in a room the some way you drew a rectangular room: 
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1. Depress the left mouse button in a room 

2. Without releasing the mouse button, move the mouse cursor to where you would 
like the opposite corner of the hole to be. Note: When first creating a hole, all 
points defining the hole must lie within the same room 

3. Release the mouse button when you have the right size hole.  

The Rectangle Hole button continues to be in effect until you select one of the other 
drawing buttons. 

4.2.4.  Polygon Hole 
To switch between the room line drawing tool and the non-rectangular hole-cutting tool 
click the drop down arrow next to the Polygon tool and select the Polygon Hole tool. 
When selected, the toolbar button changes to show a polygonal room with a hole cut out 
and the cursor includes scissors to indicate hole cutting is active. 

To cut a polygonal hole in a room click the locations inside a room where you would like 
the corners of the hole to be. 

The Polygon Hole tool continues to be in effect until you select one of the other drawing 
buttons. 

4.2.5.  Close Room 
This button draws the last wall of a room for you. It will only be active if you are in the 
process of drawing a room. 

4.2.6.  Cancel Line Draw 
 This button deletes the room you are currently drawing and lets you start your room 
drawing effort over. It will only be active if you are in the process of drawing a room. 

4.2.7.  Delete Side 
This button deletes either the first or last side of a room that is in the process of being 
drawn. If no side is selected, it will delete the last wall that you drew. This button will only 
be active if you are in the process of drawing a room. 

4.2.8.  Highlight Tool 
This button allows you to select most objects, like points, walls, rooms, or pieces on the 
stock. 

To select two or more object simultaneously: 

1. Click on the highlight button on the tool bar. 

2. Hold the Shift key or the Control key down as you click on the objects you want 
to select. 

3. If you click on the wrong object, click on it again with the Control key down, 
and it will become unselected. 
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Some actions require that you select more than one object at the same time. For example: 

• To align or position rooms, you must select two points. 
• To attach text to a room, you must select a text object and a room. 

4.2.9.  Text Tool 
You can add informative text to your room view by using the Text Tool button on the tool 
bar. 

Click the button, and then click the location in the room view where you would like your 
text to appear. This will bring up the Add Text dialog box. 

If you wish to edit the text you have entered, just double click on the text you wish to 
change. The Edit Text dialog box will allow you to edit the text. 

To delete text, click on the Highlight button, and then click on the text you wish to delete. 
When the text is selected, it will change to the highlight color. Press the Delete key or 
select Delete from the Edit menu to delete the text. 

4.2.10.  Door and  Window Tools 
Natural light from windows and the high traffic of doorways can make carpet seams easier 
to see. FloorRight uses the location of doors and windows when producing an automatic 
layout, and tries to place seams as far away as possible. 

To draw a door or window: 

1. Click on the add door or add window button (above) 

2. Position the mouse cursor on the wall where you would like the object to begin. 
Press down on the left mouse button. 

3. Without releasing the mouse button, drag the mouse cursor to the other edge of 
the door or window frame. Keep an eye on the lower left corner of the screen to 
see the width. 

4. Release the mouse button when you are satisfied. 

5. For doors only: After creating a door, a Transition Properties dialog box will pop 
up.  Length can be updated by using the length drop down menu or simpy typing 
a new length, a different Transition Material can be selected, and you can 
optionally select a hinge side and direction of door swing. (see the dialog on page 
21) 

 

Since doors are used by the layout algorithm to determine where seams go, and since you 
can drag rooms around the screen without affecting the layout, each room needs its own 
copy of the door. If two rooms are next to each other, draw a door for each room. 
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4.3. Seam Tools 

4.3.1.   User Added Seam Tool 
FloorRight locates seams to minimize the amount of waste, based on the information you 
provide. Sometimes, however, it is desirable to add a seam or relocate a seam for reasons 
that are difficult to describe to a computer. 

You can add a seam in room view before doing a layout, or you can add a seam in seam 
view, after FloorRight has generated a layout. 

To add a user defined seam: 

1. Click the seam button on the toolbar (above). 

2. Move the mouse to the wall that you want to start the seam from. 

3. Press down on the mouse button where the seam should begin. 

4. Without releasing the mouse button, move the mouse cursor to the wall or seam 
where your new seam will end. If this is a valid seam location, FloorRight will 
display the horizontal or vertical distances along the walls. 
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5. Continue to drag the mouse along the 
second wall until the distances are 
correct. If you have a difficult time 
getting the distances exactly right 
you can always place the seam near 
the correct location and then drag the 
seam after it has been created. 

6. Release the mouse button to place 
the seam. Your new seam will appear 
as a solid line across the room. User-
created seams are always displayed, 
even in room view. 

If you are not satisfied with the result, you can 
use undo, or delete the seam and try again. You can also move the seam by selecting and 
dragging it. 

 

 

If you have difficulty adding seams, it may be caused by having rooms that are adjacent to 
one another. You may have selected the wall in the wrong room and be inadvertently 
trying to create a seam between two different rooms. To overcome this, drag the room 
away from the other rooms and try again. 

4.3.2.  Deleting Seams 
First select the seam you want to delete. Next, click the eliminate seam button , which 
will be activated as soon as you select a seam. 

Note that after you eliminate a seam, that room will become locked. A locked room will 
not get re-laid unless you explicitly reset the layout. 

Some seams cannot be deleted. You cannot delete a seam if… 

• The width of the new piece would exceed the width of the stock. 

• Deleting the seam would make an L shape from a T-seam. In this case, you must 
first delete the dependent seams that are attached to the seam you want to delete. 

4.3.3.  Moving User Added Seams 
You can move most user added seams. You cannot move any computer-generated seam. 
To move a user added seam: 

1. Select the seam using the selecting tool (above). 

2. Click down on the seam. 

3. Move the mouse to drag the seam to its new location. Note the measurements 
above and below the room these are the distances between the seam you are 
moving and the wall or seam next to it. 

4. Release the mouse when you are satisfied with the result. 

You cannot move a seam across walls. You can move seams that have dependent seams. 
The dependent seams will automatically adjust to fit. 



 

4.4. Zooming Tools 
You can use these tools either from the toolbar or from the View drop down menu. 

Sometimes it is nice to get a close-up view of a room in order to do some detail work, or to 
select a seam that is very small. Other times you would like to get the entire layout on one 
screen. Both of these can be accomplished through zooming. Zooming changes the scale of 
the screen, without altering any of the work you have done. 

If you are in seam view, you must click on the window you would like to zoom first. The 
seam view shows up in the upper half of the screen. It contains the floor plan of the job. 
The Stock view shows up in the lower half of the screen and contains the cuts and the stock 
of the material that will be used in the job. 

FloorRight supports five kinds of zooming: 

Icon Menu Item Description 

 Zoom In Zoom in reduces the scale of the current window by a 
factor of two, making everything look twice as large. 

 Zoom Out Zoom out increases the scale of the current window by a 
factor of two, making everything look twice as small. 

 Zoom to Height This tool adjusts the scale of the current window to 
encompass the full height of the drawing, top to bottom, 
including a small margin. 

 Zoom to Fit This tool scales the screen so the entire drawing is 
shown. 

 Zoom Box Zoom Box lets you select a region of interest on your 
diagram, and fits that region onto the screen. To use this 
tool, draw a box around the area that you want to zoom. 
FloorRight then scales the screen to the box that you 
have drawn. 

 Zoom Restore This tool has no button on the toolbar. You can only use 
it from the View menu. Zoom Restore reverses a 
zooming action, restoring the window scale to its 
previous state. 

4.5. Layout Tools 

4.5.1.  Viewing the Seam/Stock View 
Clicking the stock toggle button on the tool bar or selecting View Seam/Stock Layout 
from the Layout menu will split the window into two parts. The top part of the window, 
called the seam view, displays the location of seams in the rooms. The lower part of the 
window, called the stock view, displays the stock and how to cut it. 
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4.5.2. Flipping Seams 
Flipping seams starts the seams on the other side of the room. This could create more or 
less waste, depending on the rooms.  To flip the seams, select the room to change seams, 
then click either: 

The horizontal flip button  moves the seams from left to right. 

The vertical flip button  moves the seams from top to bottom. 

You can get back to the original layout by selecting the Layout menu and choosing Reset 
Layout. 

4.5.3. Modifying Lay Direction 
You can change the lay direction of the material for the entire floor plan, or for individual 
rooms. If you do nothing, the lay direction will be in the east-west direction, horizontally 
across your screen. To change the lay direction to North-South, vertically up and down 
your screen, click on the North-South lay direction button  on the toolbar or select Lay 
Material N-S from the Layout menu. To change back to East-West, select the east-west 
lay direction button  on the toolbar or select Lay Material E-W from the Layout menu. 

4.5.4. Setting a Specific Lay Direction for Individual Rooms 
In addition to setting the lay direction for the material, you can choose to set the lay 
direction on a room-by-room basis. This will over-ride the  and  tools for a specific 
room.  When a lay direction has been specified for an individual room, the lay direction for 
that room is indicated with a small arrow. 

To change the lay direction of an individual room, select the room or side and choose one 
of these options from the Layout/Lay Room menu: 

• Lay Room North 
• Lay Room South 
• Lay Room East 
• Lay Room West 
• Lay Room As Material – default 
• Lay Room To Side 

 
The “Lay Room As Material” option indicates that you want no special treatment for this 
room after all.   
 

4.5.5.  Locking a Room 
Locking a room will freeze that room and prevent it from being re-laid when trying the 
different layout option buttons . Locking only affects the different layout options, 
nothing else. You can still change the room’s dimensions, carpet style, or make any other 
changes. 

If you make any changes to a room that invalidates the seams, the room will become 
unlocked and will be re-laid. For example, if you change the dimensions of a room or 
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change the material used in that room, that room’s layout is not correct any more so it will 
become unlocked and will be re-laid. 

4.5.6.  Different Layout Options 
When you eliminate a seam, FloorRight leaves all the other seams alone. Essentially, the 
layout is frozen and the only change that is made is the seam that you have eliminated. 
This feature makes the layout predictable, but it may not always provide the best layout. 

If you’ve eliminated a seam, it may be possible to re-lay the other rooms and get a better 
overall layout. The  buttons let you force a re-layout in all rooms where a seam 
was not eliminated. They become active only after you’ve eliminated a seam. 

Button  shows the layout that you just created by deleting one seam. Button  will 
show another layout option, which includes the same or fewer seams than layout . 
Button  will optimize layout  by adding new seams. 

Icon Function Description 

 Restore Layout Restores the layout you had before trying the  
or  layout options 

 Re-lay unlocked rooms, 
does not increase seam 
count. 

This layout option re-lays all unlocked rooms but 
will not increase the seam count in a room. For 
example, if an unlocked room had 2 seams before 
performing layout option 2, it will have 2 or fewer 
seams afterwards. The seam count should never 
increase. 

 Re-lay unlocked rooms, 
seam count not frozen 

This layout option re-lays all unlocked rooms 
without added restrictions to the seam count. 
Whatever the seam count is set to in a room’s 
layout properties will be used. For example, if an 
unlocked room had 2 seams before performing 
layout option 2 but that room can allow up to 5 
seams, its seam count might increase up to the 
allowable maximum. 

4.5.7. Resetting the Layout 
You can reset the layout for any specific material by selecting that material in the drop 
down (or by selecting a room that is using that material) and selecting Reset Layout from 
the Layout menu. This will reset all layouts for that material. It will not reset user added 
seams. The only way to remove user added seams is to select and delete each seam. 

4.6. Job Estimate Dialog Box 
The Job Estimate dialog box contains an itemized quote for the job you are estimating. 
When you complete the estimate, this report can be printed and given to your customer. 
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To see the Job Estimate dialog box, press the Job Estimate button  from the toolbar, or 
select the Job menu and choose Job Estimate. 

 
Clicking the maximize button on the upper right of the Job Estimate dialog box will cause 
it to fill the entire screen, allowing you to see much more of the information at one time. 
Clicking again will return the dialog box to its original size. 

4.6.1. Color 
This is the color key for your layout display. It also shows the material type description for 
that material. 

4.6.2. Item Name 
This is an identifier for the material being used. Usually this will be the manufacturer and 
style of the material, once it is decided upon. 

4.6.3. Description 
This is a textual description for the material. 

4.6.4. Based on 
This is the measurement that the price of this line item is based on. The  measurements you 
can select from are: 

• Material area – area of the material being used, including waste. 
• Room area – area of the rooms for which this material is used. 
• Linear distance – the length of the material in case you measure the materials by 

length of used roll. 
• Room perimeter – the sum of the lengths of the walls of the rooms. This only 

applies to the main room material 
• Seam length – the total of all seam lengths for all rooms for which this material is 

used. 
• Fixed – a set price, entered under Unit Price for this line. 
• Base area - the carpet area required for carpet base (calculated as room perimeter 

times the base height) 
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• Tile count - area covered by the tiles.  Note: this area will be larger than the 
material area because partial tiles (at the edges of the rooms) are counted as 
whole tiles. 

• Hole perimeter - the sum of the lengths of the edges of the hole. Again, this only 
applies to main room material 

• Room count – count all rooms using this material. 
• Inside corner count – Inside ninety-degree corner counts of the rooms.   
• Outside corner count – Outside ninety-degree corner counts of the rooms.  

Inside/outside corner counts do not include stairs. 
• Adjusted room perimeter - the sum of length of all the walls of the rooms that are 

counted in adjusted room perimeter.  To select specific walls to be removed from 
the adjusted room perimeter, go to Wall Properties (Edit/Wall Properties) and 
uncheck Count in Adjusted Room Perimeter. 

• Step count – number of steps in all the stairs using this material. 
• Adjusted base area – uses the Adjusted room perimeter above to calculate the 

base area  (calculated as adjusted room perimeter times the base height) 
• For transitions, this value defaults to the Based on value set in the Transition 

Materials dialog.  Values can be changed to the same values available in the 
Transition Materials dialog. 

4.6.5. Length 
This is the length of the material, if applicable. 

4.6.6. Quantity 
This is the amount needed. The quantity can be edited only when the Based on entry is set 
to “fixed.” Otherwise, the software computes it. 

4.6.7. Waste 
The percent of the stock that is unusable after cutting. This is the minimum amount of 
waste, as determined by the software. 

For materials that do not require layout, a waste percentage can be defined in the Edit 
Material Type dialog box. Ceramic, for instance, has a fixed waste percentage due to 
breakage and borders. In this case FloorRight uses 5% as a default. If you want to change 
this percentage, you need to go to the Defaults menu, then click on Material type. Select 
the waste cell for the material you want to modify and enter the new waste percentage. 

4.6.8. User Add 
You can add a value in this column to provide for an additional margin of error. Stock 
materials are expressed in linear units of roll material. Other materials are expressed as a 
percentage of the job area. 

4.6.9. Boxed, Amount/Box, and Boxes 
For material which is sold by the box, such as tile, check the Boxed column and enter the 
Amount / Box in the current units.  FloorRight automatically calculates the Boxes needed 
for the job in the next column. 
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4.6.10. Unit Price 
This is the cost of the material or labor (fitting), based on the Based on column. If you are 
basing this line on Fixed cost, this is the cost for one item. 

4.6.11. Subtotal 
This is the price for this line, before sales tax or value added tax. The row subtotals are the 
subtotals for a particular material and its associated items. 

4.6.12.   Tax 
The sales tax or value added tax for this line item. 

4.6.13.   Price 
This is the total price, including tax, for this line.  The grand total for the entire job is 
shown just below the scroll bars on the display. 



 

5. Opening, Saving, and Closing Files 

5.1. Saving Your File 
At some point, you will want to save your file. You may wish to do this as you exit 
FloorRight, or in the middle of your work as a precaution against power failure or other 
mishap. 

To save your file for the first time without exiting FloorRight, select the File menu and 
choose Save. You are prompted to enter Customer Information and a file name. 

5.1.1. Naming the File 
When you save your file for the first time, you will need to decide on a file name and a 
directory for your file. Choose a file name that reminds you of what is in the file. If you do 
not choose a directory, your file will be saved in the folder where you installed 
FloorRight. 

 

5.1.2. Customer Information 
If you have not entered customer information for this file, you must do so before you save 
or exit. FloorRight requires that at least a customer name, telephone number and job 
information be supplied before saving or closing the file. 

29 



 

  
Job information is designed to store information that is meaningful to you. An example 
would be to enter a unique identifier to distinguish this job from other jobs. 

Click OK when you have entered at least this information. 

5.2. Opening an Existing File 
After starting FloorRight, select the File menu and choose Open. A dialog box very 
similar to the save dialog box will be displayed. Select the file you wish to open, or type in 
the name of the file. Click OK when you have finished. 

For quick opening, the last four files you created or modified are listed at the bottom of the 
File menu. 
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6. Setting Up Defaults 
There are several items that are set up for your environment: Material Type, Room Layout 
Styles, Job Estimate Items, Sales Tax, Fonts, Company Information, Setting / Clearing the 
Splash Screen, and Options. You can set your defaults once, as you start using 
FloorRight, and then save them as a template for all the FloorRight files you create using 
the Save File As Template... item from the File menu.  Later, you can make changes to the 
template as necessary. Note, that your defaults will only be saved if you save them as a 
template, otherwise, they will not be saved. 

6.1. Material Type 
Defining material types allows you to express the properties of the materials you are 
working with.  Does it require layout?  Should you allow T-Seams?  What is the pattern 
like?  How is it sold and installed? 

Specify the answers to these questions using the Edit Material Types dialog box.  Access 
this dialog box by selecting the Defaults menu and then choosing Material Type. 

 
FloorRight™ provides many standard material types.  If you do not see one that fits your 
material, you can change one of the existing types, or create your own.  Simply click on the 
box you want to change and type in your changes 

6.2. Room Layout Styles 
Room layout styles help you to specify the types and quantities of seams for a particular 
type of room.  For example, you are likely to allow more seams in a closet than in the 
middle of a highly trafficked hallway.  The Room Layout Styles dialog box is accessed by 
selecting Defaults from the menu and then selecting Room Layout Styles. 
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6.3. Job Estimate Items 
Estimate Items are additional items, which would be associated with a given material in 
your estimate.  The most common items, pad, labor, and carpet base are permanent items in 
the list.  You can add as many additional items if you like but only the first 32 items will 
appear in the Edit Material Type and New Material – Detailed dialog boxes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

To access the Job Estimate Items dialog, select Job Estimate Items from the Defaults 
menu.  

Insert your additional items by name and "Based on" (cost basis).  This information is 
conveyed to the New Material - Detailed and Edit Material Types dialog boxes, and the 
Job Estimate screen.  Items will appear in the estimate in the same order that they appear 
here.  You can drag and drop items into a different order. 
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6.4. Sales or Value Added Tax 
Your region may impose sales taxes or value-added taxes on the goods and services you 
provide. 

 
Different areas have different rates of sales tax or value added tax. One company might 
assess different tax rates for different customers, depending on their residency. Some areas 
may tax labor (fitting) at a different rate than they tax materials. FloorRight 
accommodates all of these conditions. 

To define sales tax rates, select the Default menu and choose Sales Tax. To record a new 
tax rate, select Add. To change an existing tax rate, select the rate you wish to change and 
then select Edit. 

If you have multiple tax rates, they are listed alphabetically. You should be careful because 
the first one listed is used automatically. 

To change the tax rate used, select the Job menu and choose Job Estimate. Clicking on 
the tax quantity for a particular line item will allow you to choose the correct tax. This 
needs to be done for each line item in the estimate. 

6.5. Company Information 

 
Enter information about your company by selecting the Defaults menu, and then selecting 
Company Info. This allows you to specify your company's name, address and phone 
number. 
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6.6. Units of Length and Area 
FloorRight can work with square yards, feet and inches, or meters. To change the 
measurement system, click on the Defaults menu and choose Options. The following 
dialog box will appear on the screen. 

 

Click on the little arrow  on the right of the Length units and Area units input boxes 
to see the available options for units of measurement. Then click on the units you prefer to 
use. Click on OK to accept the changes and go back to the application. 

Note that changing your units will clear out any rooms that you have drawn. You will be 
prompted to save your drawing beforehand. 
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7. Importing Leica Disto Data into FloorRight  
You can automatically enter room measurements into your project with the Leica Disto 
laser range finder.  Take measurements, label the rooms and groups of rooms, then plug the 
Disto into your serial port and make your layout.  Once you have checked the rooms in the 
Disto Data window, you can transfer the drawings into FloorRight with the click of a 
button. 

Here's how the interface between the Leica Disto and FloorRight works.  See the 
FloorRight Instruction Manual for the Leica Disto for help in gathering data.  With the 
Disto connected to your serial port, select File / Import / Disto.  

 
Here you have a choice of Direct, File, or Interactive.  Usually you will use Direct to bring 
in the data from the Disto device, but occasionally you might want to save the raw Disto 
data to a file in for examining later, e.g. if the file contained errors.  If you have saved a 
.csd file and now want to create a FloorRight project from it, select File and use the 
standard Windows Open dialog to bring in the data file.  Interactive is designed to 
interactively create a series of rooms, which can be imported into FloorRight or saved into 
a file. This file can then be imported into FloorRight using the usual Disto Import File 
method. 

Whether you created a .csd file or brought the data in directly, the information is displayed 
in the Disto Data dialog box.   
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Check the data for errors, making any necessary corrections, then click Commit Checked 
to convert your measurements into a FloorRight drawing.  From the FloorRight room view 
you can rearrange the rooms as needed.   

If you are using Disto Pro, once your data is safely loaded into FloorRight, don't forget to 
delete it from your Disto device; otherwise the old data will be included with the next 
batch of data you collect. 
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8. Bitmap Import 
If you have a picture of your layout in bitmap form (e.g. a PNG file from a scanner) you 
can use it to help create your FloorRight project.   

Using the Import / Bitmap option in the File menu, you can import the following type of 
files into FloorRight  

• IMG 

• PNG 

• JPEG 

• TGA 

• PCX 

• TIF (uncompressed only) 

• BMP 

You can arrange the display and set the scale of your bitmap with respect to your 
FloorRight drawing in the Floor Plan Bitmap Properties dialog 

 
The Floor Plan Bitmap Properties dialog can be left open while working on the project.  
Changes in the settings take place immediately. The OK button closes the dialog saving 
the changes; the Cancel button closes the dialog and reverts the settings to their previous 
value. 

The bitmap file's path and property settings are saved with the FloorRight file and reloaded 
whenever the FloorRight file is opened. 
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9. Import From Scanner 
If you have a hard copy of your floor plan you can scan it into FloorRight with any 
"TWAIN" device.  The scanned input is saved as a bitmap file.  

Following are steps for importing drawings directly from a scanner  

1. Place your paper copy in the scanner 

2. Click File / Import / Scanner  

3. Select a source from the list of all available TWAIN sources.  

 
When you make your selection you will advance to the scanning mode. The menu for 
adjusting the settings is controlled by your scanner's software.  All scanning controls, 
including cropping, color depth, resolution, etc., are enabled.  Note:  use the monochrome 
setting if possible; it uses less memory. 

After the image is scanned, it is transferred to FloorRight and the orientation window is 
displayed. 

 
This allows you to change the orientation of your bitmap on the FloorRight grid by 90° 
increments.  The numbers indicate the clockwise rotation from ↑  North 

You can experiment with rotations until you get the desired orientation.  Then click OK to 
insert the scan at the displayed orientation into FloorRight.  The Cancel button inserts the 
scan into FloorRight at the original orientation. 

To start over (rescan), select File / New and repeat this process without saving the current 
bitmap.  

Once you have your scanned image in FloorRight, the Floor Plan Bitmap Properties 
dialog is displayed and you can create your FloorRight project. 
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When the FloorRight file is saved, the scan is automatically saved as a bitmap file with the 
name "xxx_scan.png" where "xxx" is the FloorRight file name.  The bitmap file and 
associated properties are saved and automatically loaded whenever you open the 
FloorRight file.



 

10. Licensing FloorRight 

10.1. Purchasing a License 
FloorRight™ is initially installed with a time expiring trial license. It can only be run for 
60 minutes with partial functionality. To purchase an unlimited usage license for a single 
computer, you must contact your FloorRight distributor. The distributor will provide you 
with a WIBU-key that allows you to run FloorRight. 

 

10.2. Configuring a License 
To configure your license, select License Info from Help menu. This will bring up the 
“FloorRight License Information” dialog box. 

If you have a WIBU-key connect locally to your computer, then a dialog box similar to the 
following will appear: 

 
If FloorRight has used a network license before, then you will get a dialog box similar to 
the following: 
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If FloorRight is running in trial mode, then the following dialog box will be displayed: 

 
You cannot switch to regular mode if FloorRight is running in the trial mode. You must 
exit FloorRight, plug in the WIBU-key and then start FloorRight again.
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11. FloorRight Commercial 
The main feature of FloorRight Commercial is digitizer support. The addition of a 
digitizer allows you to enter blueprints or drawings in a fraction of the time and with fewer 
mistakes. 

FloorRight Commercial will support the newest digitizers. The only requirement is that 
your digitizer uses a WinTab driver. If you are unsure if your digitizer uses a WinTab 
driver, refer to your digitizer documentation or contact the digitizer vendor. 

Other features available only in FloorRight Commercial are AutoCAD import and page 
tabs. 

11.1. Digitizer 

11.1.1. Setting up the Digitizer 
There are two ways to calibrate the digitizer. If you know the actual scale, ¼ inch = 1 foot 
for example, you can enter in this scale. If you don’t know the exact scale, if you think the 
blueprint could be stretched, or if the blueprint isn’t plumb on the digitizer, you can 
manually calibrate the digitizer scale. 

Condition Digitizer Menu Option 

Exact scale is a ratio, for example 50 to 1. Set Fixed Scale 

Exact scale is a relation, for example ¼ inch = 1ft, Set Fixed Scale 

Scale is not known Manually Scale 

Blueprint is not plumb on the digitizer. Manually Scale 

 

11.1.1.1.  Setting a Fixed Scale 
If you know the scale then select Set Fixed Scale from the Digitizer menu. 

Option When to use 

Set Ratio You know the scale as a ratio, for example 50 to 1. 

Set Fixed Scale You know the scale, for example ¼ inch = 1ft 

You may want to use the digitizer in a non-standard orientation, for example when the 
power cord is in an inconvenient position on the digitizer.  

You may use any edge of the digitizer as the “top.” There is a picture of the drawing in 
relation to the digitizer’s standard orientation.  In this orientation, the physical top of the 
digitizer will be the top (or north) of the drawing.  If you wish to reposition the physical 
top of the digitizer, click on the radio button  that matches the physical top of your 
digitizer. 

11.1.1.2. Manually Calibrating the Digitizer 
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If you do not know the scale, select Manually Scale from the Digitizer menu. This will 
bring up the Manually Calibrate Digitizer dialog box. 

 
The current scaling is displayed as text in the top right section of the dialog box. This 
dialog also displays a graphical representation on the left side. The graphical representation 
shows a square drawn on the digitizer screen. If the current scaling is rotated or stretched, 
the square will become slanted or stretched. The square also displays an arrow on the left 
side of the square. This arrow is pointing NORTH. If the scale is rotated, for example if the 
digitizer is turned upside down, this arrow will display the rotation. 

11.1.1.3. Calibrating 
Calibrating the digitizer is as simple as clicking on two points on a line. The farther away 
the two points are, the more accurate the calibration will be. After you click on the second 
point, FloorRight will display the length and direction of the line using the current scaling. 
Enter a new length and direction and click NEXT to enter an additional calibration line, or 
click OK to finish manual calibration. 

If you’ve made a mistake when clicking on the first or second point, don’t enter a new 
value for the calibration line and don’t click on the NEXT button. Instead, reenter the first 
and second point. FloorRight will only accept a calibration line when you click the NEXT 
or OK buttons. 

11.1.1.4. Compass Directions 
FloorRight uses a compass to specify direction. The calibration lines use the same 
directions that are used when defining walls. 

11.1.2. Using the Digitizer 

11.1.2.1.  Entering Rooms 
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You can use the digitizer to enter rectangular rooms, polygonal rooms, rectangular holes, 
polygonal holes, windows, and doors. You can also use the digitizer for the zoom-box 
mode. 

First, using the toolbar, select the button for the type of entry that you want to perform. 
Next, using the digitizer puck, click on each point that defines the object. Do not drag. Any 
operation that is normally a click and drag operation with the mouse will be click, release, 
then click again with the digitizer. For example, to define a rectangle, perform a two-click 
operation, one click on each diagonal corner of the room. 

Curves may be entered with the digitizer using the polygonal room or hole mode.   

• Left click on the starting point of the curve, right click near the middle of the arc, 
and right click over the end point to create the curve. 

• Continue right clicking to make additional curves.  Every two right clicks define 
a curve 

Tool Icon Function Description 

 Draw rectangular room or 
hole 

Click on one corner (for example top 
left), and then click on the opposite 
corner (for example bottom right). 

 
Draw non-rectangular 
room or hole 

Click on each end point for each wall. 

  Add a door to a wall Click on one side of the door. Then click 
on the other side to complete the door. 
Note: the door must be drawn on an 
existing wall. 

  Add a window to a wall Click on one side of the window. Then 
click on the opposite side to complete 
the window. Note: the window must be 
drawn on an existing wall. 

  Zoom Box Click on one corner (for example top 
left), and then click on the opposite 
corner (for example bottom right). 

 

11.1.2.2. Digitizer Entry Status 
FloorRight will display the current entry status when entering rooms, adding a door or a 
window, and when zooming to a box. You can cancel an operation by clicking on the 
CANCEL button in the digitizer status window. 
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11.1.3. Digitizer Button Template 

  
11.1.3.1. Activating the Button Template 

1. Attach the button template to the digitizer. 

2. Activate the toolbar by selecting Button Template from the Digitizer menu. 
This will put a check mark in front of the Button Template. 

3. Using the digitizer, click on the top left corner of the button template. Next, click 
on the bottom right corner. You will see the button template drawn on the 
digitizer screen in the Button Template dialog box. Verify the positioning.  

4. Press ACCEPT if the size and positioning is correct. If it is not correct you can 
redefine the button template by clicking on the top left and bottom right corners 
again. 

HINT:  FloorRight includes several button templates, but if you don’t have a button 
template handy you can print this page and cut out the picture. 

11.1.3.2. Deactivating the Button Template 
Selecting Button Template again will deactivate the digitizer button template and remove 
the check mark from the menu item. 

11.1.3.3. Using the Button Template 
The following tables describe the buttons that appear on the digitizer button template: 

Button - Row 1 Description 

 Digitizer Mode 
Toggles digitizer mode ON and OFF 

 Line Draw Mode 
The upper left half starts a non-rectangular room 

The lower right half starts a non-rectangular hole 

 Rectangle Mode 
The upper left half starts a rectangular room 

The lower right half starts a rectangular hole 

 Door Mode 
Adds a door to a wall 
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 Window Mode  
Adds a window to a wall 

 Close Room 
Closes a non-rectangular room 

 Cancel Line Draw  
Cancels the drawing of a non-rectangular room 

 Delete Room Side 
Deletes the last non-rectangular room side that was 
drawn. 

Button - Row 2 Description 

 Zoom Box 
Lets you select a region of interest on your diagram, 
and fits that region onto the screen 

 Zoom to Height 
Scales the screen so that the entire height of the 
diagram is visible 

 Zoom to Fit 
Scales the screen so the entire drawing is shown.  This 
is especially useful if zooming and scrolling too much 
have gotten you lost. 

 Zoom In 
Gives you a closer look at your drawing 

 Zoom Out 
Provides a bigger perspective 

 Zoom to Digitizer  
Scales the screen so the entire digitizer drawing surface 
is visible. 

 Undo  
Undoes the last action 

 Redo  
Reinstates actions that you have undone. 

 

11.2. AutoCAD Import 
If you already have a floor plan layout in AutoCAD, DXF or DWG format file, you can 
use it to help create a FloorRight project.  From the File menu select Import / AutoCAD 
to bring an AutoCAD file into FloorRight.  



 

 
 

The import automatically opens the AutoCAD properties dialog.  If you've already attached 
your AutoCAD file to a FloorRight file, you can bring up the properties dialog box from 
the Edit / AutoCAD Properties menu selection.  

 
The AutoCAD Properties dialog can be left open while working on the project.  Changes in 
the settings take place immediately. The OK button closes the dialog saving the changes; 
the Cancel button closes the dialog and reverts the settings to their previous value.   
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The AutoCAD file's path and property settings are saved with the FloorRight file and 
reloaded whenever the FloorRight file is opened. 

11.3. Page Tabs 
The page tabs feature in FloorRight Commercial is a handy way of organizing large or 
complicated jobs.  Some useful applications are: 

• Grouping rooms, for example by floor or wing of the building. 

• Importing an AutoCAD drawing with layers; you may want to put layers on 
separate pages. 

• Trying different layouts or options; you could copy the rooms in your drawing to 
multiple pages and change the defaults and layout options for quick comparisons.  

Page tabs are found at the bottom of your screen.  Click the tab of the page you want to 
display. 

You can Add, Insert, Delete, Rename and Rearrange page tabs.   Invoke the popup menu 
by one of these methods: 

• Move the cursor over the tab and right click the mouse  

• From the Edit menu select Pages. 
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12. Frequently Asked Questions 

12.1. Questions About Styles and Types 

12.1.1. What is a material style? What is a material type? How is it 
different from a material? 
A material style is a description that many materials can belong to. For example, a material 
style might be: 

• Carpet 

• 12 feet wide, 

• Requires a pad (underlay), 

• Does not have a pattern 

Your customer might want carpets that are all of this style, but in three different colors. In 
this case you cannot use the same color of material to do the estimation because the waste 
and the cost calculation will be wrong. 

The stock view is initially zoomed to show the pieces of the currently selected material. To 
see the stock of another material, you can either scroll the stock view or select another 
material by room or via the material drop-down. 

12.1.2. When do I use Add New Material and when do I use 
Detailed New/Edit? 
Use Add New Material for entering materials. Use Detailed New/Edit for editing 
materials or if you want to enter a particular name or description for a material. 

12.1.3. Why can’t I just use the same material all the time? 
In some instances, you can. You can totally ignore materials and material types as long as: 

• All of the rooms in the estimate are using the same carpet. 
• The carpet has the same settings as the default. 

You must use materials and material types if: 

• You are using a carpet with different settings from the default. 
• You are using more than one kind of carpet. 
• You are using ceramic tile, vinyl, wood, or any other types of flooring material. 

Materials and material types allow FloorRight to figure out the best way to lay out the 
materials, and how to calculate the amount of money to charge the customer. 

12.1.4. What is a room style? 
The room style lets FloorRight know what types of seams and how many seams it can 
use. It is different if you want to cover a closet or a hall. You probably don’t want T-seams 



 

in the hall, but you might allow more seams in a closet. Selecting the appropriate room 
style will give you more accurate estimates and will save material. 

12.2. Questions About Drawing and the Display 

12.2.1. How do I create stairs? 
Stairs are a little more complicated to describe than other rooms, since you can’t simply 
draw them on the screen. You have to describe the rise, run (or tread), and width of each 
step and the number of steps 

To create a new set of stairs, select the Edit 
menu option and choose Stairs, which will bring 
up a dialog box.  

Type the rise and run of the steps, as well as the 
width of each step and the number of steps. 

The Stair Orientation controls allow you to 
display the stairs left-to-right or top-to-bottom 
on the screen. This is an important consideration 
that affects the direction the carpet is laid. 

The Pile Direction menu allows you to decide 
the unrolling direction of the carpet. 

If you keep in mind that the shapes in room view 
represent carpeting rather than the dimensions of 
rooms, it is easier to understand the appearance 
of the stairs on the screen. Stairs are shown as if 
they have been flattened out, so that all of the 
carpeted surfaces are apparent. 

If you have a set of uneven stairs, you may wish to make a new set of stairs each time the 
rise changes. Another way would be to use the biggest rise to prevent running short on 
carpeting. 

12.2.2. Why are the room name and dimensions so hard to read in 
the room view? 
If you have problems interpreting the measures of a room, you might want to zoom in the 
drawing. This will allow all the dimensions to appear more separated from each other. To 

do that click on the Zoom In button  located in the left side of the tool bar. 

12.2.3. How important is it for the floor plan to look right? Is it OK 
just to have the sizes of the rooms correct? 
You don’t need to have actual distribution of the rooms on the screen. However the 
orientation of the rooms is pretty important and has to be preserved in the estimation 
layout. As soon as you have the correct dimensions and orientation, the layout will be 
correct. However you may want to give a print out to your customer.  If so, you may want 
a layout that is close to the actual job. 
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12.2.4. How do I get two rooms exactly next to each other? 
It can become quite tedious to align rooms by carefully dragging them around the room 
view. Two tools are available to make this easier and faster. 

The first step in using both tools is to select the corners of the rooms you wish to align. 

1. Click on the corner of the first room. When the rooms are aligned, this room will 
remain stationary. A small black circle on the corner of the room will indicate 
that you have been successful. 

2. Hold down the Shift key, and click on the corner you wish to align. The circle on 
the first room will turn white, and a small black circle will appear on the corner 
you have clicked. 

3. If you want to position the two corners together, the easiest way is to select the 
Drawing menu and choose Align Points. The second room you selected is 
moved so that the two corners meet. 

4. If you need to place the corner of a room a certain distance from the corner of 
another room, use the Position Room dialog box from Default menu. 

 

12.2.5. When I’m looking at the Stock View and the Seam View, 
how can I tell which piece goes with which room? 
There are two ways of knowing which piece goes in which room. If you want to know 
which pieces belong to a particular room, the best way to do it is by clicking on that room. 
The pieces of the stock belonging to that room will appear highlighted in the stock view. If 
you want to know which room a particular piece belongs to, you can click on that 
particular piece on the stock. It will appear highlighted in the room view. 

12.2.6. I can’t get a wall to be just the right length. 
You can make an approximate drawing of a room using the drawing tools and then enter 
the exact dimensions of each wall in the line length box. 

Drawing a room with the rectangle or polygon tool is pretty easy. However getting the 
exact dimension of the room can be harder. 

If you want to draw a wall with an exact dimension, the easiest way is selecting the wall 
with the selection tool, then typing the length on the line length box and the direction in the 
direction box, located in the center of the tool bar. This will correct any error in the current 
length of that particular wall. 
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12.2.7. Why would I want to add windows to a room? 
Sunlight shinning on seams makes them more noticeable. If you add a window 
FloorRight will try to avoid seams near that window. 

12.2.8. I keep losing my doors. Where are they? 
Each room is plotted in the screen as a transparent layer. When you align two rooms, the 
doors on the shared wall might not show up on the screen. In this case the missing doors 
were added in the room that is displayed in the back layer. To see the doors: 

1. Click the highlight button on the toolbar. 

2. Click on the room you wish to bring to the front of the display. If you cannot see 
any of the room, try using Send To Back from Edit menu on a room that might 
be covering it up. 

3. Select the Edit menu and choose Bring To Front. 

Remember, since doors are used by the layout algorithm to determine where seams go, and 
since you can drag rooms around the screen without affecting the layout, each room needs 
its own copy of the door. If two rooms are next to each other, draw a door for each room. 

12.2.9. Where does the “Add Text for Printing” text go? 
Any text that you enter through the Add Text for Printing dialog box will appear in the 
printouts of the rooms, seams, stock, and job estimate. You can see the text by selecting 
Print Preview Rooms or Print Preview Stock from the File menu or by clicking on the 
Print Preview button in the Job Estimate dialog box. 

12.2.10. Why do some rooms disappear when I go into the stock 
view? 
Rooms that have non-roll goods in them, such as wood or ceramic, will disappear in seam 
view. FloorRight does not create a layout for these materials, so the rooms are not 
displayed. 

A second reason might be because the screen has a limited area to show the stock and the 
layout. Thus, the stock window covers some rooms. If you want to see those rooms you 
just have to use the scrollbar, located in the right edge of the window. 

If you want to see the whole layout, you can click on the zoom to fit button. You will have 
a reduced view of the entire layout on the screen. 

12.2.11. How can I tell the seams FloorRight has made from the 
seams I have added? 
The seams made by FloorRight disappear every time you de-activate the layout button 
whereas the seams created by you will appear in the room view permanently. Also, the 
seams you have added will be a dash-dot line pattern. 



 

12.2.12. I was zooming, and now my screen is blank. What 
happened? 
Sometimes when you are zooming in an image, the size becomes so big that the portion of 
the drawing that fits on the screen can be just a small part of the drawing. In that case the 
screen can appear completely white or any other color. 

There are many ways to go back to a more familiar screen. The buttons Zoom to Fit, 
Zoom to Height, Zoom Restore and Zoom Out, will reduce the size of the drawing. 

12.2.13. How do I change my grid? 
You can modify the size of your grid by clicking on Defaults. This will display a drop 
down menu. There you will select Options. Click on the Drawing tab.  In this dialog box 
you will be able to modify or restore the settings of your grid. 

• Grid spacing: The distance between the fine lines on the grid. 
• Major grid spacing: The distance between the thick lines on the grid. 
• Snapping distance: When grid snapping is turned on, this is the finest 

incremental change allowed when drawing a rectangle or a line. 
• Grid on: When checked, the grid is displayed in the room view. You can also 

turn the grid on and off using the grid button on the tool bar. 
• Grid snapping: When selected, drawing lengths are rounded based on the 

snapping distance. 
• Horizontal/Vertical snapping: When selected, drawing lengths are rounded 

based on the snapping distance near horizontal/vertical grids. 

You can also toggle the grid on and off using the View Grid  button. 

12.3. Questions About the Layout 

12.3.1. How do I account for cabinets, islands, bathtubs, and other 
forms of “negative space” in a room? 
First create the room; then either using the rectangle hole or the polygonal hole to remove 
the “negative space” 
 

12.3.2. What does it mean to “lock a room?” 
If you spend a lot of time changing and revising the seam layout, you may wish to lock a 
room against subsequent changes. 

Lock a room means that all the pieces and seams that are currently in the room will remain 
there regardless of further changes you make to other rooms in the same job. In other 
words, this feature freezes the layout of the room you locked. 

12.3.3. I can’t figure out how to lock a room. The lock icon never 
seems to be enabled. 

To lock a room, you need the stock layout button activated . 
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1.  Select the room and then click on the lock room button on the toolbar . 

2.  Select the room and click the button again to unlock the room. 

If you change the lay direction of the material, the room will be unlocked for the new lay 
direction. 

12.4. Questions About Job Cost 

12.4.1. How do I enter prices? 
The price per unit of a material can be entered when you first create the material with the 
New Material - Detailed dialog box from Edit/Material List. You can also enter the 
material price in the Job Estimate dialog box from the Job menu, as well as prices for 
labor (fitting), padding (underlay), and other related items. 

12.4.2. What can I give the customer when I’m done? 
Your customer basically wants a quote for a job. Hence the main piece of information will 
be a printout of the job estimate. However if you want to give more credibility to your 
quote a printout of the room view and the stock view will give a very good impression to 
your customer. 

12.4.3. Where is the total price? 
The total price will appear on the bottom of the screen in the room and seam views. The 
total price will also appear in the last row of the job estimate. Notice that the total price 
will not be shown in the printouts of the room view or the stock view. 

12.4.4. How do I add sales tax or value added tax? 
In the job estimate view there is a column for tax purposes. Different areas have different 
rates of sales tax or value added tax. One company might accrue different tax rates for 
different customers, depending on their residency. Some areas may tax labor at a different 
rate than they tax materials. FloorRight accommodates all of these conditions. To define 
sales tax rates, select the Default menu and choose Sales Tax. To record a new tax rate, 
select Add. To change an existing tax rate, select the rate you wish to change, and then 
select Edit. If you have multiple tax rates, they are listed alphabetically. The first one listed 
is used automatically, so be careful. To change which tax rate is used, select the Job menu 
and choose Job Estimate. Clicking on the tax quantity for a particular line item will allow 
you to choose the correct tax. Even though this needs to be done for each line item in the 
estimate, it is very likely that you do not need to modify the taxes very often. 

12.4.5. How do I account for waste in ceramic tile or wood? 
Ceramic tile and wood are examples of materials that do not need to be laid out in order to 
know the approximate waste. 

FloorRight provides many standard material types. If you do not see one that fits your 
material, you can change one of the existing types, or create your own. Simply click on the 
box you want to change and type in your changes. This allows you to pre-set an estimated 
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amount of waste for a material. It does not apply to materials that are laid out, since their 
waste depends on the sizes and shapes of the rooms. An example of how this would be 
used would be to estimate that 5% of ceramic tile is wasted through cutting and breakage. 

12.4.6. How do I add additional charges for items that FloorRight 
does not compute? 
In the Job Estimate dialog you may include any additional items that you want to add to 
your estimation. In the column Based on you can select which measurement will be used 
to measure the price of each line. You can select from several different measurements. If 
you want to charge per room the best way to do it is by selecting a fixed price, then in the 
Quantity column you would enter the number of rooms.  In Unit Price, add fixed price for 
each room.   

12.4.7. How do I change the currency symbol 
You can change the currency symbol through Microsoft Windows. FloorRight will use 
whatever currency symbol you have set. 

1. Double-click on the My Computer icon on the desktop. 
2. Double-click on the Control Panel folder 
3. Double-click on the Regional Options icon 
4. Choose the Currency tab. 

Enter or select your currency symbol in this dialog box, and click OK. FloorRight will 
automatically use the currency symbol you have chosen. 

 


